
Palette: The specific 256 colors a segment uses out of all the millions of available RGB colors Only a 
concern on 256 color systems since true color and high color systems always have all the colors and 16 
color systems all use the same 16 color palette.



A Quick Example
Your first screen saver

You may have experimented with the Screen Saver Studio interface and found it easy to use. If you found
it confusing then follow along and do the actions in the actual program while reading this example.

Let's make a star float around the screen to the song Twinkle Twinkle Little Star. At the end of the loop, 
the star will wink. Then some text adds the final touch! A few segments is all it will take!

When you first launch Screen Saver Studio, a blank session appears:

As you see above, Segment 1, (the big black box) is highlighted. You know it's highlighted because the 
words "Segment 1" at the bottom are in blue. (There is also a dotted line around the black box but 
sometimes it's hard to see.) Double-click on the segment 1 box or just press <Enter>. You now see the 
following Segment dialog:

This dialog window features all the things that may be controlled in a segment. We want to add our star 
graphic. Click the Graphics button to add a graphic. You now see:



The upper left corner area has 10 slots for graphics. The first slot is highlighted and it says <none>, 
meaning there is no graphic in that slot. Above the slots section it says "Graphic: [double-click]", so 
double-click on slot 1 or press <Space> to change the graphic in slot 1. This brings you to:

This is a standard file selection dialog. We've already moved to the SSSTUDIO\SOURCES\TWINKLE 
directory. There are two graphics in that directory - star1.bmp and star2.bmp. Star1.bmp is currently 
highlighted and you can see a thumbnail preview of it in the lower right hand corner. Since this is the 
graphic we want, click OK to return to the Graphics for Segment dialog. It now looks like this:



Graphic slot 1 now says star1.bmp and you see a preview of what's in the highlighted slot below the slot 
list.

The center section, the Define Graphic box, has a Speed slide that defaults to 10. Change it to 30 to 
speed the motion of the graphic up a little bit by clicking on the right arrow of the slide bar, or by dragging 
the thumb to about the middle and then clicking just outside of the thumb. There is also a Motion pull 
down menu in this box. Click on the menu and select the Bounce motion so the star will float around the 
screen and bounce off the edges.

At the bottom of the center section is the Graphic Starting Point box. This has controls for both the X axis 
and the Y axis. Click on the pull down for each axis and change them to the Keep Old setting. (This 
becomes important later on when we want our star to move fluidly by beginning a segment where it ends 
the last one.)

The upper right section, the Fading for Graphics box, controls how the star gets on and off the screen. 
Change the Fade In effect to Zoom and set the speed bar for the effect to 75. At this point your screen 
should look like this:

When you have all the settings correct, click on the OK button and return to the segment controller.



When you return to this dialog, you should see the star zooming in and bouncing around the screen! Now 
let's add the song. A song is something you hear, so it's an Audio setting. Click on the Audio button and 
you'll see the Audio dialog:

Click on the Select button and you'll see the standard file selection dialog box. This opens in the last 
accessed directory which should be where you got the star graphic from - and the only audio file to pick is
twinkle2.wav. Select it and click OK.

In the Action pull down, change the setting to Continuously. This will make the sound automatically play 
again (or loop) when it finishes playing all the way through. Click OK to get back to the Segment 
controller.



The star will still be bouncing around, but now you will hear the song! (Assuming, that is, that you have a 
sound card and your speakers are turned on!)

We want our star to bounce around for a little while, so click on the Duration button to get to the duration 
dialog:

The Stop after x seconds radio button is already selected, so just change the value in that box to 6. 
(This means that after the star fully zooms onto the screen, it will bounce around for 6 seconds and then 
the segment will be over.) Click OK to return to the segment controller. This segment is finished, so click 
OK to return to the main screen:



The music stops and you see what we put in slot 1 - our star!    To add a new segment, click on the box 
labeled End of List. This highlights it. Now press the <Insert> key on the keyboard or click on the Insert 

new segment button  on the tool bar. Your main screen becomes:

All of segment 1 has been copied into segment 2 for you. This is usually a good thing since you don't 
have to enter everything by hand to make small modifications. Double-click segment 2 and the segment 
controller dialog again comes up.

If you play a sound in a segment, it always stops any sound still playing from a previous segment. Right 
now, the twinkle.wav is set to play in segment 2 just like it was in segment 1 - which will stop the song 
right in the middle and start paying it again. This is not what we want! Click on the Audio button and then 
click on the Clear button to change the twinkle.wav to <none> in segment 2. Now the song from 
segment 1 will play continuously like we want it to.

We also do not want the star to zoom-in in this segment - we want to keep it the same size. So click on 
the Graphic button and change the Fade In pull down menu to Instantaneously. Also in the graphics 
controller, change the motion from bounce to stationary.

Finally, click on the Duration button and change the duration to 1 second.

Get back to the main screen and click on the End of List segment and insert another new segment. You 
now see:



Double-click on segment 2 and click on the Graphics button. Double-click on graphic slot 1 and change 
the star1.bmp to star2.bmp.

When you get back to the main screen you see:

The star is winking! Now we need to change segment 3 slightly, so double-click on segment 3 to edit it. 
Click the duration button and increase the time to 3 seconds then click OK.

Click on the Graphics button and change the Fade Out setting to zoom and click OK. This is because we 
zoomed-in in segment 1, so we want things to work nicely when we go from segment 3 to segment 1.

Click on the Text button to add a message. You will see the Text controller dialog:



Click in the define text box in the upper left hand corner and enter your message. We typed "Hello 
World!!!". The text will come up in the middle of the screen, but since the star will be in a random place it 
will not usually be obscured by it. Click the OK button, then click the OK button on the segment controller 
to get back to the main screen.

Save your file by clicking file|save or click on the save icon ( ).

Now let's preview the screen saver to be sure it's doing what we want. Click on the preview icon ( ) 
and you should see a dialog that says segment 1. The star should be bouncing around and zooming in 
and the song should be playing. After a bit, the dialog should change to segment 2 and the star should 
stop moving and wink. Then segment 3 should play where the star zooms out and the text comes up. 
After that it goes back to segment 1. To get out of the preview mode, press ESC or double-click on the 
control menu box of the segment dialog.

If something is wrong, go back to the proper segment and edit it. If everything seems to be OK, we want 

to create the screen saver by clicking file|build SCR/EXE or click the build SCR/EXE icon ( ) in the tool
bar. You will see the build dialog:

You must enter a Selection Name. This is the name that your screen saver will have in the control panel. 
We called it Sample Screen Saver above. You can enter description text in the description box - this is 
only visible when looking at the screen saver setup. You should make sure the Calculate Global Palette 
button is selected, then click on OK.

You will then be asked where and under what name to save the SCR. Type in "FIRST" and press 
<Enter>. This will make the screen saver go into the Windows directory.

After some progress thermometers go by, you'll see the following dialog:



If you click on No, you are done! Your screen saver, FIRST.SCR is in the Windows directory and can be 
selected like any other screen saver.



ANM: An animation file created with Animcomp. These files play a sequence of images in order within a 
single segment. ANM files created with other programs will not work in Screen Saver Studio!



AVI: A common form of graphic movie. AVI's can only be played in Graphic Slot 1. The user of the screen 
saver needs an AVI player on his system!



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Screen Saver 
Studio.



Adding Audio to a segment

Sounds can make your screen saver come alive! If you have WAV or MIDI files, you can easily add them 
to your screen saver. Click on the dialog graphic for specific help.

Tricky Tip: You can create a sense of random sound by associating sound with an invisible, bouncing 
graphic or text that is just a single space For instance, a 1x1 pixel, black graphic with the motion set to 
bounce will generate the desired sound when it bounces off an edge of the screen. Since the graphic is 
invisible, the sound will have the appearance of being random! If you then duplicate a run of segments 
with a duration of 1 second, you change the sound in each one for further randomization.



Adding Graphics to a Segment
Graphics are the "actors" in your screen saver. There can be up to 10 different graphics per segment and 
up to 50 copies of each graphic. Graphics can be static or they can be special "animations" that are 
contained in a single file. They can be given different movement commands and can enter and exit the 
screen with a variety of fade effects.

Click on the graphic below for more help.



Adding Segments to a Screen Saver Document
Screen Saver Studio can make screen savers with up to 1,000 different segments. Adding a segment is a 
form of inserting a segment. To add a new segment to your screen saver, highlight an existing segment by
clicking on it. The segment you are adding will be inserted before the highlighted segment. If you want to 
add a segment to the end of the screen saver, click on the End Of List segment.

To add the new segment, press <Insert> on your keyboard or click on the Insert New Segment Icon in the 
Tool bar. When you insert a segment this way, it is automatically filled with the contents of the segment 
before it.

If you want to insert a new segment that is a duplicate of some other segment in your document, simply 
select that segment and copy it to the clipboard by pressing <Ctrl+C> or clicking the copy icon in the Tool 
bar...

...then highlight a segment and click the Paste Insert Icon in the Tool bar or select Paste Insert from the 
Edit Menu <Ctrl+A>. The copied segment will be pasted before the highlighted segment.

...or highlight a segment and click the Paste icon in the Tool bar or select Paste from the Edit Menu 
<Ctrl+V>. The copied segment will replace the highlighted segment.

The following sequence should make this all clear...

The screen below shows a screen saver with one segment. The text tab is showing the contents of the 
text field in all segments. As you can see, the text for segment 1 is a "1".

Below, the End of List segment has been highlighted. The highlighted segment has its name in a blue 
box.



Below you see the results of hitting <Insert> - the contents of Segment 1 are copied automatically into 
segment 2. The new segment is also highlighted.

Below shows the result after editing the text in segment 2 to "2". Then we copied this segment to the 
clipboard by pressing <Ctrl+C>.

Now segment 1 has been highlighted.



The Paste Insert command causes the segment to be inserted before the previously highlighted segment.

If you then highlight segment 2 and use the Paste command, you will replace the contents of the 
highlighted segment with what was on the clipboard.



Adding Text to a Segment
Each segment can have one text message associated with it. Text always appears over all graphics - it is 
the top-most layer. Just like a graphic, you can make the text move and control how it enters and exits the
screen.

Tip: If you want to combine different fonts, color and styles in a single text block, you have to make the 
desired layout in a paint program and save it as a graphic.

Click on the graphic below for more information.



Adding a Background Graphic or Color to a Segment

The background is the mat on which all other actions take place. It can be as simple as a solid color, or as
pretty as a full screen scanned-in photo. Backgrounds always appear instantaneously at the beginning of 
the segment and remain for the entire segment. All other graphics and text appear over the background - 
it is the lowest layer.

Click on the dialog graphic for specific help.



The Audio action pull down menu lets you pick how or when to play a sound:

Once- the sound is played once at the beginning of the segment. It may or may not be finished when the 
segment ends, so it could continue into the next segment. See also Audio Check Boxes.
Continuously- the sound starts at the beginning of the segment and plays in a continual loop, so be sure 
it sounds okay when repeated. If a sound is played in a later segment, it will stop the continuously looping
sound. To restart the loop, set it up again in another segment. In such a case, to make it seamlessly loop 
from the end of the screen saver to the beginning, make sure to have a continuously playing sound in 
Segment 1 - even if it's part of an Intro Clip - or else the sound will "jump".
Associate with Slot 1-10- plays the sound whenever any graphic in the chosen slot exits or bounces off 
the edge of the screen. Multiple copies of graphics bouncing around can cause many sounds to be 
generated. See also Audio Check Boxes.
Associate with Text- plays the sound when the text exits or bounces off the edge of the screen.



When the Allow Interruption within Segment box is checked, if a sound is playing when a new one is 
supposed to begin, the current sound will be stopped and the new one played. Otherwise, the current one
continues until it is finished. This only affects sounds in a single segment! If a sound plays into another 
segment, any new sound will always stop the current sound and begin the new one.

The Stop Sound at End of Segment check box, if checked, will make sure that any sound will be ended 
when the current segment ends, even if the duration of the sound is longer than the segment.

These may be checked in any combination.



The Audio Clear button clears the audio selection to <none>. It leaves the check boxes and action 
unchanged since these can affect sounds which began in a previous segment.



The audio select button calls up a standard file selection dialog that allows you to find WAV or MIDI files. 
As much of the path as can be displayed will be over the select button after a selection is made.



Audio Stop Button
Pressing this button stops the sound that was started by pressing the Test 
button.



The Audio Test button plays the sound or song you have chosen. You can go select another while the 
current one is playing, or click OK to exit the dialog and stop the song.



The background preview window shows a sample of how the background will look. A tiled graphic will 
show as much of the path name of the selected graphic as will fit and tile the graphic in the display 
window, a solid color will show the selected color, and sticky will just be completely grey with no evidence 
of a window outline.



The background Select button is dimmed out when sticky is selected, otherwise you must click here to 
bring up the color selection dialog for a solid color background or a standard file selection dialog to select 
a tiled graphic background. The selection dialog defaults to showing all supported graphic file formats.



A solid color background is just that - a solid color. It is the fastest way to draw the background. You will 
need to click on the Select button to bring up the color palette. Click on the color you want for your 
background, then click OK.



A sticky background retains everything that is drawn on it - it never erases. Objects that move across the 
screen leave a trail as they go. This can be a very interesting effect. You need to have sticky selected in a
run of segments to retain the effect - as soon as a non-sticky (i.e. solid color or tiled graphic) background 
segment is encountered, the screen will be cleared to whatever was selected in that segment.



A tiled graphic background will take the selected graphic and tile it - that is, repeatedly draw it over and 
over again until the entire screen is covered.

It is important to remember when working with tiled graphics that you do not know what resolution the end
user of your screen saver will be running under. If you have a "full screen" 640x480 background graphic 
and they are in 800x600 resolution, your background will be tiled - which may be undesirable. Similarly, if 
you have an 800x600 graphic and the end user is in 640x480 resolution, they will only see the upper left 
hand corner of the background.

The background is redrawn every update (see Update Rate) and it takes longer to draw many tiles than 
fewer. Thus, a single pixel can be tiled to make a blue background, but this is much slower than tiling a 
large blue graphic, which is slower than just using a blue Solid Color background.



Use the build browse button to select the icon for your screen saver screen. It calls up a standard file 
selection box so you can find any ICO file on your hard drive. You can create your own icon using the Icon
Editor program (See more in the Icon Editor section)



In the build description box, enter any information you want to appear when the user selects the 
Settings button for the screen saver. The text is automatically word-wrapped, so don't press <Enter> 
unless you want to start a new line. Each line of the description text will be centered.

This text will be seen when a screen saver is installed, so you can use it as a read me. The description 
text will not be seen if you build a presentation EXE.



The build icon currently selected for the screen saver is shown in here. The icon appears as the icon for 
the SCR file and in the settings dialog. you must have an icon - if you really don't want one, use the 
CLEAR.ICO we've provided - it's completely transparent.



The build palette radio buttons give you control over the palette in your screen saver. The options are:

Rainbow (all Segments) - this is exactly the palette you see while building and previewing your screen 
saver in 256 color video mode. It makes a fairly good approximation for most graphics, but is bad for 
photographs.
Global (all Segments) - this takes all the graphics from the entire screen saver and makes the single 
best palette. The results are usually very good. There is never a palette flash between segments, but it 
can take a while for the palette calculation during the build.
Dynamic (per Segment) - this takes all the graphics in each segment and determines the best single 
palette. This is excellent for slide shows, but, if you don't fade each graphic to black before a new 
segment, you will see a palette flash.
Dynamic (per Clip) - this takes all the graphics in each clip and determines the best single palette for 
each one. This avoids palette flashing. between segments within clips, but not between the clips 
themselves.

Palette selection only has meaning when you are in 256 color video mode when the screen saver kicks in.
For all other video setups, this setting is simply ignored.

See also Color Considerations



The reset button makes the icon the default icon - a monitor being saved by a life-saver. (Get it?)



Build SCR/EXE (File menu)

Use this command to create a screen saver file (and possibly a program to easily install it, too).    For 
more information, see Building New Screen Savers (.SCR files) or Programs (.EXE files).

Shortcuts

Tool bar:
Keys: CTRL+B



Enter the build selection name which will be seen when you are selecting the Screen Saver from the 
control panel. This name is limited to 30 characters not 8 since it is not the file name.

Windows 95 Note! The screen saver control panel of Windows 95 will only show one screen saver with 
identical selection names - the first one installed. If you build TEST.SCR with a selection name of TEST, 
then make changes and build TEST2.SCR while keeping the selection name TEST, the control panel will 
only show TEST, and it will point to TEST.SCR. So change the selection name too or you'll wonder why 
your changes aren't showing up! (Windows 3.x will just show multiple copies of the word TEST, just pick 
the right one!)



Choose what type of file to build by selecting the appropriate build type radio button. You may create a 
screen saver (SCR file), or a presentation (EXE file). The presentation option creates a program that runs 
only when you launch it and is exited only by a key press -- the mouse is ignored and movement or clicks 
will not exit it like a normal screen saver.

If your screen saver has AVIs or MIDIs in it, when you build an SCR you will be told that a self-installing 
EXE will be created. This is not the same as a presentation EXE! After this installer is run once, the SCR 
is installed on the system and will function like any normal screen saver.



Building Your Screen Savers
After you have completed and saved your screen saver document to disk, you are ready to build a 
Windows-ready screen saver module (.SCR file) or a runnable program (.EXE file). Select Build SCR/EXE
File in the File Menu (Ctrl+B) and you will see the following dialog.

Click on the graphic below for more help.

You must enter a selection name! After you've made the rest of your choices and click OK, you are 
presented with a standard Save As... dialog to name the resulting SCR or EXE file - which must be a 
standard 8 character filename. Choose the directory where you want to save it (usually Windows for an 
SCR) then click OK.

After the SCR or presentation EXE is saved, you are asked if you want to make an installer for the screen
saver. Do this if you want to give your screen saver away to friends. It makes an installation file that not 
only installs the SCR file into the Windows directory, but also makes it the default screen saver!

If you have a MIDI or AVI file anywhere in your screen saver, you will be forced to create an installer since
the MIDIs and AVIs must be placed on your hard-drive as separate files.

If you make an installer you will be asked where and under what name to save it. In addition, you can 
compress the installer - this takes a while, but can make it significantly smaller.

NOTE! It is important that you compile your screen savers on your hard drive and then transfer them to a 
floppy disk. If your screen saver is larger than the amount of free space on your diskette, Screen Saver 
Studio may, in some cases, fail to notify you and continue to build your screen saver incorrectly.

Exit Screen Saver Studio or press Alt+Tab to access your Windows desktop. You can then activate your 
new screen saver by selecting it the same way you normally select a screen saver. (i.e., Windows 3.1 
users should double-click the Control Panel then Desktop icons in the Main Program Group; Windows 95 
users should right-click on the desktop, select Properties, then select Screen Saver). If your new screen 
saver does not appear in the list of available screen savers, use the Windows Find File option to locate 
the .SCR file you created. Move it into your Windows directory then make it your current screen saver as 
previously described.



Cancel "forgets" everything you've done and reverts back to things the way they were before you came in
here and started messing around...



Choose Color dialog box

Choose the color you want to be the background.



Choose Font dialog box

Choose the font you want your text to appear in. If you are sending the final screen saver to 
someone else, and the font you choose here is not installed on their system, Windows will choose the 
best font it can and will substitute it. If the look of the font is important, then make sure the snapshot 
check box is turned on.



Clear Segment (Edit menu)

Use this command to clear the current segment of all graphical content.    This command is unavailable if 
you are at the End of List.

Shortcuts

Tool bar:
Keys: SHIFT+ENTER



The Clear Segment Button makes all the settings in the Graphic, Text, Background, Audio and Duration 
fields revert to their default state.



Clips
A clip is a run of segments that is always played in order. Thus, a simple screen saver that begins at 
segment 1, goes to segment 2, segment 3 etc. until it reaches the last segment is actually a single clip.

After the last segment of a clip is played, the first segment of a random different clip is then started. The 
simple screen saver mentioned above has no other clips to choose from, so it plays the same one again 
from the beginning.

To make a clip, darken the clip dot on the left side of the desired starting segment and the clip dot to the 
right side of the ending segment - not the ones in between. If the dots on both sides of a segment are 
dark, then you've made a single segment clip. You have to make sure that all the settings in the starting 
and ending segments make sense when they follow or precede any other clip since you don't know what 
order they will be played in.

The very last clip dot in your screen saver will always be dark The very first clip dot can be dark or light 
and controls the final clip feature - the Intro clip. The Intro clip is a clip that is played once at the beginning
of the screen saver and then never played again. If the first clip dot is white, then everything from 
segment 1 up to the first black clip dot is an intro clip. (In the simple screen saver, the single clip is 
actually an intro clip - it is played repeatedly since there is nothing else to play!) If the first clip dot is dark, 
then the the first clip will be treated like any other clip and played randomly.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the window or dialog box



Color Considerations
The most important thing to consider when creating your screens saver is that if you give your screen 
saver away, you do not know what color resolution the user will be running under! All screen savers will 
look pretty much alike when run on true (16 million) or high (65 thousand) color systems. And the only 
way a screen saver can look good on a 16 color system is if all the graphics were created using the 
standard Windows 16 color palette. Which leaves 256 colors...

In general, you need to support 256 colors if you are going to allow your screen savers to get out into 
general circulation since about half of the systems still only support 256 colors. High color or true color 
graphics can look pretty bad under 256 colors if you use the wrong settings You can still use high color or 
true color graphics and get good results - you just have to understand what's going on.

IF YOU WORK ON A 256 COLOR SYSTEM...
...when you are editing and previewing your screen saver, you are in a general rainbow palette. Your final 
screen saver will probably look much better than this! The only way to know for sure is to build it and test 
it.

IF YOU WORK ON A HIGH COLOR OR TRUE COLOR SYSTEM...
...what you see when you edit and preview your screen saver is exactly what the final screen saver will 
look like - when run on high color or true color systems! The only way to know how good or bad it will look
on a 256 color system is to build it, change your system's color depth to 256 colors and then run your 
screen saver.

IF YOU WANT TO SUPPORT ONLY HIGH COLOR OR TRUE COLOR SYSTEMS...
...then use the Rainbow Palette option when building your screen saver. No palette calculations are made
and the build is not slowed down at all. This will probably look bad if it is ever run on a 256 color system!

IF YOU WANT TO SUPPORT 256 COLOR SYSTEMS...
...then use either the Dynamic Palette or Global Palette settings during the build. The Dynamic Palette 
setting should be used only for true slide shows; that is, a series of single images displayed one at a time.
You should fade each slide to black before going to the next image, or you will get a palette flash between
segments. In all other cases, the Global Palette setting is the preferred one - you'll get the best looking 
screen saver but it can take a long time to build. If your screen saver has high color or true color graphics 
in it, it will look good on 256 color systems and will look best when run on high color or true color systems.

THE DECREASE HIGH COLOR DEPTHS CHECK BOX...
...should be used to save on the final screen saver size. It takes all high color and true color images in 
your screen saver and reduces them to 256 colors. (In your screen saver only, not the original files on 
your hard-drive!) This will save 50% or more on the final screen saver size. A by-product of this setting is 
that the screen saver will look exactly the same on 256, high color and true color systems.

WORKING WITH PHOTOS...
...scanned-in photos are usually in high or true color - so you'll usually want to use the Decrease High 
Color Depths checkbox.

One final note. If you are running under 256 colors and have a web browser open to a page with an 
animating GIF or even banner ads that are getting updated, when a screen saver kicks it will look fine 
until the web browser updates. The browser takes control of the palette and ruins the look of the screen 
saver. This is the browser's fault!



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Tool bar:
Keys: CTRL+C



Creating New Graphics and Animations
If you have an art program or a scanner, you can create new graphics for Screen Saver Studio. 

You just need to know and keep in mind a few technical details.
The first thing to consider when making graphics that will be moved around on the screen is that 

smaller is better. Make them just large enough to get the desired effect across. This is both for memory 
usage as well as the fact that moving full screen images around is inherently slow.

The next thing to remember is to be careful when using true black (color zero). True black can be 
made transparent, so a white disk surrounded by black can be made to look like a disk moving across the
background. If you put another black disk inside the white disk, it will look like a doughnut because the 
background will show through the hole. If you want a white disk with a black center that stays black, you 
need to make the center disk "not quite black". i.e. RGB values of 12,12,12 or a very deep purple, etc.

The final thing to remember is that no matter what external file format you create your graphics in,
they will be converted into a standard format internally in the finished screens aver. This may make your 
screen saver larger than expected. You can use the Decrease High Color check box to make scanned 
photos significantly smaller.

Animation files (ANM) are single files that contain many images. These images are displayed one
after the other in the same segment - thus giving the impression of movement.You can use ANIMCOMP* 
to create your own. The instructions for Animcomp are given when you run the program, but the basics 
rules are:

1. You have to have BMPs.
2. The BMPs must be the same number of colors.
3. The BMPs must be exactly the same same width and height.
4. The BMPs must be in the same encoding scheme - either RGB or RLE.
5. The BMPs must be named in sequence with a root name and digits that increase. Something like 
STAR01.BMP, STAR02.BMP...STAR11.BMP.
6. The BMPs must all be in the same directory.

When you run Animcomp, you will be asked for a file to load. Select any frame of the series and it will find 
the lowest numbered one and turn it and the rest in sequence into an ANM file!



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on the clipboard.    
This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Tool bar:
Keys: CTRL+X



Decrease High color command (File menu)

This option should be used if size is a major consideration of your screen saver and you are using high 
color or true color graphics. It reduces all graphics to 256 colors when they are placed in the screen saver
which saves a lot of space. This has the effect of ensuring that the screen saver looks the same on all 
256, high color or true color systems, but the drawback is that on high color or true color systems, the 
graphics won't look quite as good.

This command is also available as a check box on the Build Screen Saver dialog. However, if you change
the state of the check box here, it can take a long time for all the graphics to be converted. It's much 
better to plan ahead and set this option in the File menu before you begin a new screen saver.



Default Clear makes every setting in this dialog exactly the same as the settings in the previous 
segment's dialog. A very useful way to recover from changes that didn't quite work the way you wanted...



Delete Segment (Edit menu)

Use this command to delete (remove from the list) the current segment.    This command is unavailable if 
you are at the End of List or if you have only one segment in the list.

Shortcuts

Tool bar:
Keys: DELETE



Deleting Graphics in Segments
To delete the graphics in a segment (including the background), double-click on that segment 

from the main menu (or select it and press Enter). The Segment dialog box which appears on your screen
will allow you to Clear the contents of the segment. This clears all of the segment's contents - the 
background, audio, text and duration to their default values. If you want to delete the graphics and ONLY 
the graphics in a segment, you have to click on the graphic button then Clear each graphic slot "by-hand."



Deleting Segments
To delete a segment, simply click on that segment from the main menu and press Delete or click 

the Delete Segment Icon in the Tool bar ( ).



Distributing
Your purchase of Screen Saver Studio grants you the right to freely distribute the files you create 

to friends, family members, business colleagues, clients, and customers as long as there is no charge. If 
you wish to sell your screen savers, you must obtain a licensed version of Screen Saver Studio. Visit 
www.guildsoft.co.uk or call 0800 289041 for more information.



Continuously Loop. After ALL graphics and text have fully faded onto the screen, just keep doing what 
they're doing. They never fade out (even if set to do so) and the segment never ends.



Stop after x graphic cycles in slot y. After ALL graphics and text have fully faded onto the screen, wait 
until the graphics in the specified slot have exited or bounced off the screen edge this many times, then 
begin fading out all the graphics and text. When the last one disappears, the segment ends.



Stop after x text cycles. After ALL graphics and text have fully faded onto the screen, wait until the text 
block has exited or bounced off the screen this many times, then begin fading out all the graphics and 
text. When the last one disappears, the segment ends.



Stop after x seconds. After ALL graphics and text have fully faded onto the screen, wait this many 
seconds then begin fading out all graphics and text. When the last one disappears, the segment ends. 
The maximum is 60 seconds. If you need longer than this (to delay as long as a MIDI song, for example), 
duplicate the segment as many times as necessary, setting the Fade In only on the first segment and the 
Fade out only on the last one.



Clear All command (Edit menu)

<< Write application-specific help here. >>



Clear command (Edit menu)

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item changes to 
Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Replace command (Edit menu)

<< Write application-specific help here. >>



Edit Segment (Edit menu)

Use this command to edit the currently selected segment.    This command is unavailable if you are at the 
End of List. Whenever you are editing or previewing a segment, all graphics will appear in the rainbow 
palette. See Building New Screen Savers (.SCR files) or Programs (.EXE files) for more information on 
palettes.

Shortcuts

Tool bar:
Keys: ENTER



Edit menu commands

The Edit menu offers the following commands:

Undo Undoes the last Edit action.
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Paste Insert Inserts data from the clipboard into the document.
Edit Segment Edit the contents of the selected segment.
Clear Segment Clear the contents of the selected segment.
Delete 
Segment

Removes the currently selected segment.

Insert Segment Inserts a new segment in front of the selected segment (duplicates the contents of the previous 
segment).

Toggle Clip 
Marker

Allows you to define clips.



Editing Segments

To edit a previously created segment, simply double-click on that segment from the main menu (or select 
it and press Enter). You'll see the segment dialog - click on the graphic for more help.



Element (View menu)

Determines which graphical element (graphics 1-10 or text) will be displayed for each segment in 
the segment list.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your Screen Saver Studio session.    You can also use the Close command on 
the application Control menu.    Screen Saver Studio prompts you to save documents with unsaved 
changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



New command (File menu)

Use this command to create a new document in Screen Saver Studio.

You can open an existing document with the Open command.

Shortcuts

Tool bar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document.

You can create new documents with the New command.

Shortcuts

Tool bar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

Drives
Select the drive in which Screen Saver Studio stores the file that you want to open. 

Directories
Select the directory in which Screen Saver Studio stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Save As command (File menu)

Use this command to save and name the active document.    Screen Saver Studio displays the Save As 
dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    Screen Saver Studio adds the extension you 
specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Save command (File menu)

Use this command to save the active document to its current name and directory.    When you save a 
document for the first time, Screen Saver Studio displays the Save As dialog box so you can name your 
document.    If you want to change the name and directory of an existing document before you save it, 
choose the Save As command.

Shortcuts

Tool bar:
Keys: CTRL+S



File menu commands

The File menu offers the following commands:

New Project Creates a new project.
Open Project Opens an existing project.
Save Project Saves an opened project using the same file name.
Save Project 
As

Saves an opened project to a specified file name.

Decrease 
High color 
Depths

Used to make a smaller screen saver when using true color or high color 
images.

Build 
SCR/EXE

Build and save the current document as a .SCR or .EXE file.

1, 2, 3, 4 List of your four most recent screen saver documents; click to open.
Exit Exits Screen Saver Studio.



Files Supported
Screen Saver Studio can work with a variety of bitmap and vector graphics. Formats ranging from BMP, 
JPG, PCX, WMF and more can be used to make your screen savers. Screen Saver Studio takes these 
graphics and converts them into a standard format inside the screen saver. Every format except BMP , 
will be converted into temporary files on your hard drive. In order to save on working hard drive space and
speed up loading time, you should try to work with BMPs as much as possible.

The complete list of graphics files supported is:

AVI, BMP, DIB, ANM, CMP, CAL, IMG, PNG, DIC, TIF, JPG, ICA, JFF, JTF, PCT, MAC, MSP, PCD, PCX, 
PSD, EPS, RAS, TGA, TIF, WMF, FXS, WPG, ICO, CUR.

Screen Saver Studio opens most (if not all) of the sub-types of these files.

AVI files are a common file format for video animations. Screen Saver Studio can import any AVI file, but 
it can only be placed in graphic slot 1. You may experience some palette conflicts on computers running 
in 256 color mode if you have other graphics or a background in effect while an AVI is playing. While it is 
possible to move an AVI around the screen while it is playing, it is not recommended. AVI files are 
packaged with the screen saver so be careful - it is easy for the file sizes to become large with AVI files! 
The computer on which the screen saver will run must have an AVI player installed in order to function 
properly. Windows 95 systems have one built in, Windows 3.x users will need something like Video for 
Windows. (Available at www.microsoft.com).

BMP is a standard format with two common sub-types - RGB encoded and RLE encoded. If your paint 
program gives you a choice, use RLE since it usually makes the finished screen saver smaller.

The ANM file is an animation file created with ANIMCOMP, the beta program included with Screen Saver 
Studio*. Animations created by other programs with an ANM extension will not work. We recommend you 
keep your animations in a single directory so you don't get confused.

Note: Graphics in a lossy format (JPG and PNG for example) have a compression feature that often gives
incorrect results when working with the transparent black portion of a graphic. This is because the file 
compression algorithm loses information from the original to obtain greater compression, and it frequently 
does this by saying that all near blacks become the same black since the human eye can't distinguish the 
difference anyway. Unfortunately, Screen Saver Studio can and does need a specific range of black to 
work with to make masks correctly. We recommend that you load these format graphics in a paint 
program and make sure that the masked areas are the correct black, then save them out to another 
format - BMP for example.



Find dialog box

<< Write application-specific help here. >>



Glossary
A
Animcomp: A separate beta-program included with Screen Saver Studio that allows you to take 
identically sized and formatted BMP graphics and turn them into an ANM file*.

ANM: An animation file created with Animcomp. These files play a sequence of images in order within a 
single segment. ANM files created with other programs will not work in Screen Saver Studio!

Audio: Sound of any supported format - WAV or MIDI.

AVI: A common form of graphic movie. AVI's can only be played in Graphic Slot 1. The user of the screen 
saver needs an AVI player on his system!

B
Background: The mat on which all objects are placed. All other objects are above the background.

BMP: A standard Windows graphic format. If your paint program supports it, when you create new 
graphics you should save them as RLE encoded since this usually makes your final screen saver smaller.

Bounce: A special object motion where the object bounces off the edge of the screen instead of moving 
off of the screen.



Build: To take your raw SSP file and turn it into an SCR or EXE.

C
Clip: A clip is a run of segments that plays from the first segment of the clip to the last segment of the clip.
When the last segment is played, a different clip is chosen at random to be played.

Clip Marker (or Clip Dot): The graphical indication of where a clip begins and ends. A dark dot indicates 
both the beginning and end of a clip; a light dot shows the segment is an internal part of a clip.

Compression: Making your screen saver smaller so it is easier to distribute.

D
Distribution: Giving your screen saver away for free! If you want to sell your creations, call 0800 289041 
and ask about the Professional version.

Duration: How long the movement portion of a segment lasts. It can be set to last a certain number
of seconds, or by how a certain object moves.

Dynamic Palette: A setting designed for slide shows that calculates a palette for every segment. You 
should fade each slide to black before going to the next image, or you will get a palette flash between 
segments.

E
Effects: The different ways objects can Fade In or Fade Out during a segment.

EXE: An executable program. Screen Saver Studio can build a Presentation EXE, or a self-installing 
screen saver EXE.

F
Fade In: The portion of a segment where objects enter the screen. There are a variety of effects to 
choose from.

Fade Out: The portion of a segment where objects leave the screen. There are a variety of effects to 
choose from.

G
Global Palette: A setting that takes all the graphics from the entire screen saver and makes the single 
best palette. The results are usually very good. There is never a palette flash between segments, but it 
can take a while for the palette calculation during the build.

Graphic: The main object in Screen Saver Studio. Many graphic formats are supported, but they are all 
turned into a standard format in the final screen saver.

Graphic Slot: Graphics in a segment are assigned to one of ten slots to keep track of them. The major 
function of a slot is determining how objects pass over each other on screen.

H
High Color: Also known as 16-bit or 65 thousand color, this is a video mode that displays 65,536 colors. 



(Also used to describe 15 bit color, a mode that displays 32,767 colors.)

I
Icon: A little picture that is associated with the file you create. It is also displayed in the set-up box of a 
screen saver.

Icon Editor: Accessed from the Tool menu, this is a program that allows you to create icons.

Intro Clip: If the very first clip dot is light, the first clip will be played only once when the screen saver 
begins. It will not be played again.

J
JPG: A popular, lossy graphic format. Because of the compression method used, these may not work 
properly with transparent black settings. They will become larger when internally stored in screen savers.

K

L
Lossy: A compression scheme that sacrifices information for size reduction. Usually used on graphics. 
(like JPG and PNG) under the theory that the human eye can't detect the difference between the original 
and the compressed graphic. Unfortunately, Screen Saver Studio can run into trouble with transparent 
black settings when using lossy graphic formats.

M
Mask: A way of letting the background show though a graphic. All pixels of a certain color are defined to 
be transparent. In Screen Saver Studio, the mask color is black with RGB values of 12,12,12 or less. 
Thus, in the graphic of a dough-nut, you'd make the hole the mask color so you could see it was a hole.

MIDI: A music format where instruments and notes are defined as numbers. Much smaller in size than 
WAVs, MIDIs will play on most properly installed sound cards. However, songs may not sound the same 
on different systems.

Movement: The main portion of each segment, this is where objects move around the screen. You can 
set the speed and direction of movement.

N

O
Object: Either a graphic or a block of text. Objects are the "actors" in your screen saver "movie".

P
Palette: The specific 256 colors a segment uses out of all the millions of available RGB colors Only a 
concern on 256 color systems since true color and high color systems always have all the colors and 16 
color systems all use the same 16 color palette.

Palette Flash: An annoying, often psychedelic distortion of colors that briefly occurs on 256 color systems



when displaying a new segment that uses a different palette of colors.

Password: An access feature of many screen savers. When the screen saver is exited, you are asked for
a password. If you do not enter the right one, you cannot get onto the system. It prevents unauthorized 
users from using your system while you are away. It is set in the setup dialog box. If you use one, don't 
forget it or you won't be able to get on your system either!

Pixel: The basic unit of the screen, each "dot" on the screen is one pixel. A 640x480 screen resolution 
means you can see 640 pixels across and 480 pixels up and down.

PNG: A lossy graphic format. Because of the compression method used, these may not work properly 
with transparent black settings. They will become larger when internally stored in screen savers.

Presentation EXE: A stand-alone program. It must be run like any other program - it does not run 
automatically like a screen saver. It is exited by a key press.

Preview: A way to look at your screen saver before building it. You can watch the segment number to see
where things go wrong. The preview uses the rainbow palette.

Q

R
Rainbow Palette: A general palette used while building and previewing your screen savers. It makes a 
fairly good approximation for most graphics, but is bad for photographs.

RGB: An acronym of Red, Green, Blue. It's a way of specifying a color by each of the three values which   
run from 0 (dark) to 255 (bright). Black is 0,0,0; white is 255,255,255, bright blue is 0,0,255 etc.

S
SCR: The file extension of screen saver files.

Screen Resolution: The width and height of your screen as measured in pixels. Common resolutions are
640x480, 800x600, 1024x768, and 1280x1024 but more exist. In fact, some settings can be larger than 
your screen can show - "virtual" screen sizes - but Screen Saver Studio will still work! But remember that 
when on a virtual screen, you can't scroll around to see the action which may be happening off the 
screen!

Screen Saver: A special program that is run automatically after a predefined length of time has passed 
with no input to your computer. Any key press or mouse movement exits the program. Originally designed
to keep your monitor's screen from getting burned by constantly displaying the same thing for long 
periods of time, screen savers have become fanciful, fun, whimsical programs that amuse or break up the
work-day monotony.

Segment: The basic unit of a Screen Saver Studio screen saver. Each segment has three parts: A 
beginning where objects Fade In, a middle where objects Move, and an end where objects Fade Out. 
Objects can be moving while fading in and out, and they can be stationary during the motion portion.

Slot: Graphics in a segment are assigned to one of ten slots to keep track of them. The major function of 
a slot is determining how objects pass over each other on screen.

Snapshot: A text setting that turns the text in a segment into a graphic - ensuring that all users will see 



the font and style used no matter what fonts they have of their system.

Sound: Either a sound (WAV) or song (MIDI). Only one sound can be played per segment, though it can 
be played multiple times 

Speed: The number of pixels that an object moves every update. Speed can range from 0-50.

SSP: Screen saver project. The file that tells Screen Saver Studio where to find and how to move all the 
objects in your screen saver.

Sticky: A special background where objects leave a trail behind when they move.

T
Text: An object that displays a block of text you enter. You can set the font, style, color and size of the 
text. You can have one text object per segment. The text object in all other respects acts like a graphic.

Tiling: Drawing the same graphic side by side and above and below itself to fill a large area. If care is 
taken, the edges where the graphics abut can be seamless. Vertical or horizontal lines are the result of 
improperly designed tiles.

Transparent Black: A check box setting that allows graphics or text to be masked on to the screen.

True Color: Also known as 24-bit or 16 million color, this is a video mode that displays 16,777,216 colors.

U
Update Rate: How often Screen Saver Studio redraws every object on the screen. Measured in 
milliseconds (thousandths of a second). The default of 200ms means that every 0.2 seconds objects will 
be moved and redrawn.

V

W
WAV: A sound format which digitizes an actual sound as a long string of numbers. All systems with sound 
cards should be able to play WAVs.

X
X Coordinate: In the Cartesian coordinate system, the X-axis is the horizontal axis. It is positive (+) to the
right of center and negative (-) to the left of center. In Screen Saver Studio, the center is defined to be the 
very center of the visible screen.

Y
Y Coordinate: In the Cartesian coordinate system, the Y-axis is the vertical axis. It is positive (+) above 
center and negative (-) below center. In Screen Saver Studio, the center is defined to be the very center 
of the visible screen.

Z
Zoom: A fade effect where the object grows from or decreases to a point.



The Bounce check box allows graphics using user defined motion to bounce off the edge of the screen. 
Be aware that when a new segment is begun, a user defined bouncing graphic will start the segment by 
moving in the user defined direction!



The Graphic Clear Button changes the graphic in the selected slot to <none>. It does not change any 
other settings.



Graphic Definition
The Define Graphic settings are in effect for both BMPs and ANMs. The controls in this box change 
slightly depending on the motion selected as shown below. If the Motion is User Defined, you will see the 
box on the right; any other motion gives the box on the left.

Click below for more help.

 or 



The Effect slide bar changes the rate at which the fading effect occurs - at the slow end it will take a 
lonnnng time for the graphic to fade; at the high end it is almost instantaneous. It affects both the In and 
Out effects.



The Graphic In effect determines how the graphic will arrive on the screen. The options are:

Zoom- the graphic begins as a point and becomes larger until it is full size. Note! Some video drivers will 
make zooming graphics look almost black until they are full-size. This is not a problem with Screen Saver 
Studio but with the graphics card.
Random Blocks- random blocks appear until the entire graphic is displayed. The effect speed 
determines the size of the blocks - the faster the speed, the larger the blocks.
Horizontal Expand- the center-line of the graphic appears then it expands simultaneously to the top and 
bottom.
Vertical Expand- the center-line of the graphic appears then it expands simultaneously to the left and 
right.
Horizontal Scan- the top or bottom of the graphic appears, then it builds to the other edge.
Vertical Scan- the left or right of the graphic appears, then it builds to the other side.
Instantaneously- the entire graphic appears at once.



The Motion pull down menu determines how the graphic acts on-screen:

user defined- the user gets custom control over the movement.
bounce- the graphic moves around the screen and when it reaches an edge, it bounds off in the opposite
direction.
left, right, up or down- the graphic moves across the screen in the indicated direction. After it exits the 
screen, it reappears coming in on the opposite edge in a random location.
stationary- the graphic stays where it is placed. Animations, however, could still appear to move around 
in a limited area if they were designed that way.



No. of Graphics sets the number of this graphic that will be placed on-screen. The range is 1 to 50. All of 
these graphics will initially be positioned randomly, except the first one which strictly obeys the Starting 
Graphic Location. For moving graphics, the first one will move according to the speed bar, all others will 
move randomly at the same speed or slower. (For User Defined motion, all graphics move at the user 
defined slope.)



The Graphic Out effect determines how the graphic will leave the screen. The options are:

Zoom- the graphic decreases in size until it disappears. Note! Some video drivers will make zooming 
graphics look almost black unless they are full-size. This is not a problem with Screen Saver Studio but 
with the graphics card.
Random Blocks- random blocks disappear until the entire graphic is gone. The effect speed determines 
the size of the blocks - the faster the speed, the larger the blocks.
Horizontal Contract- the top and bottom lines of the graphic disappear until they meet in the middle.
Vertical Contract- the left and right sides of the graphic disappear until they meet in the middle.
Horizontal Scan- the top or bottom of the graphic disappears, then it erases to the other edge.
Vertical Scan- the left or right of the graphic disappears, then it erases to the other side.
Instantaneously- the entire graphic disappears at once.
None- the graphic is not erased from the screen. However, other graphics moving over it will erase the 
part they move over until it is eventually erased.



The graphic preview window shows a resized version of the graphic in the highlighted slot. The 
pathname (or as much as can fit) appears above it.



There are 10 graphic slots for graphics in each segment. The slot a graphic is in affects how it acts on 
the screen. Graphics in slot 10 will always be at the lowest depth (just above the background) whereas 
those in slot 1 will always be on top (just under text.) When two graphics pass over each other, the one in 
the lower numbered slot (towards the top of the list) will be above the higher numbered one.

Double-click on a graphic slot to call up the dialog box to select a graphic or animation. The selection 
dialog has a small thumbnail of the file currently highlighted. This can be turned off in the View menu if it 
is taking too long for your system to display the preview.

You can drag a graphic from one slot to another by clicking on a slot and holding the mouse down while 
moving. This swaps adjacent slots. All the information associated with the slot is moved with the graphic! 
If you hold down the SHIFT key first, you will drop a copy of the graphic you were dragging when you 
release the button.

AVIs are a common format of video. You can use an AVI as a graphic - but only in slot 1. When you select
an AVI for a segment, you will see a check box labeled "Play AVI full Screen." If this is checked, the AVI 
will be stretched so that it fills the entire screen - no matter what resolution the screen saver is run under. 
When it is checked off, the AVI will play in its created dimensions.

AVIs are always the top-most object - they appear even above text! If you are playing an AVI full 
screen (or an AVI that takes up the whole screen) then you will see nothing but the AVI.

You may experience some palette conflicts on computers running in 256 color mode if you have other 
graphics or a background in effect while an AVI is playing. While it is possible to move an AVI around the 
screen while it is playing, it is not recommended. When in 256 color mode, AVIs can cause a palette flash 
before and after the AVI.

AVI files are packaged with the screen saver, so be careful - it is easy for the file sizes to become large 
with AVI files! The computer on which the screen saver will run must have an AVI player installed in order 
to function properly. Windows 95 systems have one built in, Windows 3.x users will need something like 
Video for Windows. (Available at www.microsoft.com).



The Speed bar determines how fast the graphic moves across or around on your screen. The speed 
number is actually how many pixels the graphic moves every update. Thus, at the default Update Rate of 
200ms, 5 updates occur every second. A graphic with a speed of 10 will therefore move 50 pixels every 
second.



The Graphics Starting Values are dimmed and can't be accessed unless Pixel Offset or % offset is 
chosen for the particular axis. Values can run from -9999 to 9999.



The Graphic Starting Point is broken into X and Y coordinates for maximum flexibility. Usually you will 
have both axes set to the same thing, but they can be different. The options are:

Keep Old- begin at the same location the graphic ended at in the previous segment. This is needed to 
maintain smooth motion of graphics from segment to segment. If there was no graphic in the previous 
segment, a Random location is used instead.
Preset- uses standard starting locations based on the selected motion of the graphic. Bounce generates 
a Random location that keeps the graphic on the screen. Stationary is centered on the axis. Left, Right, 
Up or Down motion puts the starting location just off the edge of the screen. User defined motion graphics
use a random starting location.
Random- places the center of the graphic somewhere on the screen. Thus, the graphic can start partially 
off the screen.
Left Side or Right Side on X axis, on the Y axis Top or Bottom- puts the graphic just off the indicated 
edge of the screen.
Pixel Offset- starts the center of the graphic the specified number of pixels from the center of the screen.
% Offset- starts the center of the graphic the specified percentage of the screen resolution from the 
center of the screen.



The text Keep Black Transparent check box should normally be checked. This causes all black pixels 
with an RGB value of 12,12,12 or less to be treated as see-through. If you only have one graphic over a 
black background, turn this off to increase performance.

Note- the 12,12,12 value is used to circumvent problems some video cards have with "near black" colors 
acting like 0,0,0 when you want them to be solid. This should work on most systems.



The Transparent Fade check box here is similar to the Keep Black Transparent box. You normally want 
this on unless you are working with only one graphic on a black background.



The heart of user defined motion is an understanding of the X-Y coordinate system. The center of the 
screen is 0,0. X is the horizontal axis; it increases to the right (+) and decreases to the left (-). The Y axis 
is the vertical axis; it increases to the top (+) and decreases to the bottom (-). By setting the sliders to the 
proper numbers, you can make an object move in any desired direction.

The X and Y Speed numbers represent how many pixels the graphic moves every update. Thus, at the 
default Update Rate of 200ms, 5 updates occur every second. A graphic with an X-speed of 10 and a Y 
speed of 3 will therefore move 50 pixels to the right and 15 pixels up every second.



The Help button brings up context-sensitive help dialogs.



Context Help command 

Use the Context Help command to obtain help on some portion of Screen Saver Studio.    When you 
choose the Tool bar's Context Help button, the mouse pointer will change to an arrow and question mark.  
Then click somewhere in the Screen Saver Studio window, such as another Tool bar button.    The Help 
topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

Distributin
g

Tells you how to give away your screen savers.

About Displays information about Screen Saver Studio.



Icon Editor
The only currently defined tool is Icon Editor, an add on program that allows you to create icons for the 
screen savers you create.    By selecting the Icon Editor icon from the tool bar (or selecting Tools|Icon 
Editor from the Menu Bar), you activate this program.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Screen Saver Studio and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Insert Segment (Edit menu)

Use this command to insert a new segment.    If it is not the first segment in the list, then the contents of 
the previous segment will be copied to the new segment. This command is unavailable if there are 
already 1000 segments in the list (1000 is the maximum).

Shortcuts

Tool bar:
Keys: INSERT



Inserting Segments
You can create complex and interesting screen savers with Screen Saver Studio by creating up to

1,000 different segments that "play" in segment order (1-1,000) on your screen. To insert or add a 
segment to your screen saver document, return to the main program interface (if necessary) and click on 
the segment that will follow or come after the new segment you want to insert. If you want the new 
segment to be last, click on End Of List before inserting.

To create a new segment, press Insert on your keyboard or click the Insert New Segment Icon in 

the Tool bar ( ). NOTE:    each time you insert or add a new segment with this icon or with the Insert 
key, the new segment is automatically filled with the contents of the previous segment.

If you want to insert a new segment that is a duplicate of some other segment in your document, 
simply select that segment and copy it to the clipboard by pressing Ctrl+C or clicking the copy icon in the 

Tool bar ( ). Select the segment that will follow the segment you wish to insert, then click the Insert 
New Segment And Paste Icon in the Tool bar (

) or select Paste Insert from the Edit Menu.



Installation
Before You Install:

1. Close all applications, including all screen saver programs that may be running in the background.
2. Check your hard disk space to ensure that you have the space available for the minimum installation.
3. If you are logged onto a network, log off.

To Install:

WINDOWS 3.x
1. Insert the CD-ROM into your CD-ROM drive
2. Select the FILE menu from the Program Manager and choose RUN.    The run dialog box appears.
3. In the COMMAND LINE field, type:    D:\SETUP    (where "D" is the letter of your CD-ROM Drive).
4. Click "OK" and follow the on-screen prompts. Screen Saver Studio will be installed in the directory c:\
ssstudio (or you may choose another directory during the installation process).

WINDOWS 95
1. Click the Windows 95 Start button.
2. Select the RUN option.
3. Type D:\SETUP in the COMMAND LINE field. (where "D" is the letter of your CD-ROM Drive)
4. Click "OK" and follow the on-screen prompts. Screen Saver Studio will be installed in the directory c:\
ssstudio (or you may choose another directory during the installation process).



Introduction
Welcome to Screen Saver Studio!

Screen Saver Studio is an exciting new utility for Windows that enables computer users--no 
matter what their level of computing expertise--to create professional-looking screen savers for home or 
office. If you can click your mouse you can create a screen saver that your friends, associates, or clients 
will love. To get you started we have provided you with useful sets of graphics, animations, and sounds*. 
But if you have the artistic ability to create your own graphics, you will have even more design options.

Screen Saver Studio gives you all the tools necessary to create your own screen savers! Anything you 
can imagine can be created using the simple interface of Screen Saver Studio! With Screen Saver Studio,
you can:

        Import many different graphic formats (AVI, ANM, BMP, CUR, EPS, ICO, JPG, PCX, PSD, TIF, 
TGA, WMF, WPG and more) and animate them in many different ways

        Import any WAV or MIDI file to add sound to your screen saver
        Add your own text easily
        Add transition effects for graphics and text
        Save your screen savers to give to family members, friends or business associates.    No 

additional software is needed to run the screen savers you create with Screen Saver Studio!

Children and adults will quickly create screen savers with the easy to use interface of Screen Saver 
Studio. Just a few clicks of the mouse and you are on your way to making a screen saver creation.    
Advanced users will enjoy the flexibility and many features of Screen Saver Studio as well.



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should modify a 
document using your application.    

If your application supports multiple document types and you want to have a distinct help topic for each, 
then use the help context i.d. generated by running the MAKEHELP.BAT file produced by AppWizard.    
Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the help 
context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the first 
document type supported by your application.    AppWizard produces an alias in the .HPJ file for your 
application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for that document type. >>



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Next Pane

<< Write application-specific help here. >>



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Screen Saver Studio determines which 
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the AFX_HIDP_xxx 
values from the [ALIAS] section of your .HPJ file, and author a topic for each AFX_HIDP_xxx value.    For 
example, AFX_HIDP_INVALID_FILENAME is the help topic for the Invalid Filename message box. >>



OK accepts the changes you've made and leaves the dialog.



Opening Previously Saved or Recently Saved Documents
Save your current screen saver document (if necessary), then press Ctrl+O or choose Open in 

the File Menu. Locate the previously saved screen saver document you wish to open and press OK. 
Alternatively, if the document you wish to open is a recently saved or edited file, it may be listed in the File
Menu just above the Exit command. Screen Saver Studio will always retain the names of the last four 
documents opened or saved in that section of the File Menu.

If you are working on a screen saver and wish to get rid of the changes you've made in a session,
you can't just reload the file you want - you have to do a New first.



Palette: The specific 256 colors a segment uses out of all the millions of available RGB colors Only a 
concern on 256 color systems since true and high color systems always have all the colors and 16 color 
systems all use the same 16 color palette.



Palette Flash: An annoying, often psychedelic distortion of colors that briefly occurs on 256 color systems
when displaying a new segment that uses a different palette of colors.



Paste Insert command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point. This command is 
unavailable if the clipboard is empty or if there are already 1000 segments in the list (1000 is the 
maximum).

Shortcuts

Tool bar:
Keys: CTRL+A



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts

Tool bar:
Keys: CTRL+V



Prev Pane

<< Write application-specific help here. >>



Preview (View menu)

Use this command to see what the screen saver would look like if you built it right now. Whenever you are
previewing or editing a segment, all graphics will appear in the rainbow palette. See Building New Screen 
Savers (.SCR files) or Programs (.EXE files) for more information on palettes.

Shortcuts

Tool bar:
Keys: CTRL+P



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    Screen Saver Studio determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



RGB: An acronym of Red, Green, Blue. It's a way of specifying a color by each of the three values which   
run from 0 (dark) to 255 (bright). Black is 0,0,0; white is 255,255,255, bright blue is 0,0,255 etc.







Replace dialog box

<< Write application-specific help here. >>



Resolution (View menu)

Determines how many segments will be visible in the segment list at any given time.



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Saving Screen Saver Documents
Once you have completed your screen saver document and are satisfied with the Preview (Alt 

V+P), choose Save (Ctrl+S) in the File Menu to save the document. Though it is possible to build a 
screen saver module or program without saving the current document, we recommend saving every 
document in case you want to change it or duplicate the effects you have achieved with different graphics.
Use the Save As command in the File Menu when you want to create a copy of an open screen saver 
document.



Screen Stuff
Screen Saver Studio always treats the dead center of the screen as 0,0. The X axis is the horizontal axis -
you can move left and right along it. The Y axis is the vertical axis - you can move up and down on it    
When you move up you are moving in a +Y direction, down is the -Y direction. Moving right is +X and left 
is -X. 

You can use the pixel offset when starting your graphics to put them in a specific location. The pixel range
in any direction is 9,999. That is, you can place a graphic anywhere from -9,999 to +9,999 pixels in the X 
or Y direction. Screen Saver Studio works with the dead center of a graphic as its reference point, so for a
graphic to be placed off the edge of the screen, for example, the center of the graphic must be placed far 
enough off the screen so that none of the graphic is visible on-screen. Placing a graphic at a pixel offset 
of 0,0 centers the graphic on the screen.

When you create your screen saver, you have no idea what screen resolution the final screen saver will 
be running on. It could be 640x480, 800x600, 1024x768 or even higher. The right edge is +320 X on a 
640x480 screen, the bottom edge is -300 Y on an 800x600 screen, the left edge is -512 X on a 1024x768 
screen, etc. you need to take this into account when making your screen savers. If you place something 
+400 X pixels, it may be off the screen on a 640x480 screen but visible on a 1024x768 screen!

The % Offset feature gets around the screen resolution question since it moves the center of the graphic 
the designated percentage distance from the center of the screen. The edges of the screen are always 
one-half of the distance of the screen resolution away from the center. Thus, +50% X will put the graphic 
half-off the right edge of the screen no matter what screen resolution you are running under! (It's only half-
off the screen because the center of the graphic is placed there.)

The % offset runs from -9999 to 9999. You generally won't want to go beyond 100% in any direction since
it would take a long time for such a graphic to get on the screen!



Screen Saver Studio Concept
SEGMENT BASED APPROACH

Screen Saver Studio is a segment based screen saver creator program. Think of a segment as 
one page. It contains the various elements that you add. Graphics, text, sounds, background elements 
and the like are placed in a segment. An initial transition effect (like zoom in, random blocks, or appear 
instantly), is applied along with motion (up, down, right, left, bounce, stationary). An exiting transition 
effect can then be applied as well. To complete the segment, the duration is set. This tells how long a 
segment will last (how long the objects will move or appear). Screen Saver Studio supports up to 1000 
segments. The screen saver you create will automatically run through the segments you create. It puts 
them together to form your screen saver. Combining graphics, sounds, text, backgrounds, duration, 
movements and transition effects offers almost unlimited possibilities for your screen saver creations!

Some of the best screen savers are simply one or two segments that repeat (a bouncing logo 
with background images can be quite effective). One simple example would be a screen saver featuring 
photos of the family pet. Each picture displayed would fill a segment. You would add various transition 
effects between each segment to give a slide show appearance, but basically you would have as many 
segments as you have pictures.



Screen Saver Studio Help Index
Introduction
Screen Saver Studio Concept

A Quick Example

Click on the graphic below to get help, or scroll down to go to text help topics.

Getting Started
Minimum System Requirements
Installing Screen Saver Studio
Starting Screen Saver Studio

Adding
A Segment
Audio to a Segment
Background Graphic or Color to a Segment
Graphics to a Segment
Text to a Segment

Building
Building New Screen Savers (.SCR files) or Programs (.EXE files)

Creating
Clips
New Graphics and Animations

Deleting
Graphics in Segments
Segments



Distributing
Screen Saver Studio Files

Editing
Duration of a Segment
Segments

Inserting
Segments

Opening
Previously Saved or Recently Saved Documents

Saving
Saving Screen Saver Studio Documents

Viewing
Background of a Segment
Graphics in a Segment
Preview of the Current Screen Saver
Segments in a Document

Commands
File menu
Edit menu
View menu
Help menu

Technical Information
Files Supported
Color Considerations
Screen Stuff

Glossary



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.

<< Describe the actions of the various parts of the scroll bar, according to how they behave in your 
application. >>



The Select Thumbnail Preview toggles whether or not you will see a graphic preview when you are 
selecting a graphic. It is nice to see what the graphic looks like, but it may be too slow on your system 
when opening large graphics or non-BMPs.



Setting the Duration of a Segment

As you create segments, an important consideration becomes setting how long each segment lasts. This 
is an art more than a science because of the vagaries of different systems. After all the graphics and text 
fade in, the segment lasts for the specified duration, then all the graphics and text fade out. You can 
specify the duration in one of 4 different ways - click on the graphic for more help.

NOTE! It is entirely possible to set conditions for various text and graphic elements which keep any 
segment from ever ending even when it should! Screen Saver Studio detects most (if not all) such 
conditions and warns you against proceeding.



Show Background (View menu)

Determines whether or not each segment's background will be displayed behind whichever 
graphical element you have chosen in the segment list



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Starting Screen Saver Studio
Starting Screen Saver Studio:

WINDOWS 3.x
1. From Program Manager, double-click the Screen Saver Studio Program Group icon.    
2. Double-click the Screen Saver Studio icon from within the Screen Saver Studio Program Group.
3. The Screen Saver Studio interface will load and you are ready to make your own screen savers!

WINDOWS 95
1. From the desktop, click on the Windows 95 START button. The Windows 95 menu displays.
2. Move the cursor to the PROGRAMS option. The Program Menu displays.
3. Click on the Screen Saver Studio program group.
4. Click on the Screen Saver Studio icon. The Screen Saver Studio interface will load and you are ready 
to make your own screen savers!



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Minimize command (application Control menu)

Use this command to reduce the Screen Saver Studio window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



System Requirements
Minimum & Recommended System Requirements:

Screen Saver Studio was designed for any system running Windows 3.1, 3.11 or Windows '95. (386, 
VGA, 4MB Ram, 2MB hard drive space.)

Recommended System Requirements are
486/33 IBM PC or compatible
8MB Ram
10 Megabytes of hard drive space (for work and project files)
SVGA graphics
Windows 3.1, 3.11 or Windows 95.

Basically, Screen Saver Studio and the screen savers it creates will work on any Windows system! We've
given you all the needed software to see AVIs' yourself, however, if you create a screen saver that plays 
an AVI, you must be sure that the recipient has an AVI player. Windows 95 systems come with one; 
Windows 3.x users will need to install an AVI player or when the screen saver tries to play the AVI, the 
screen goes black and stays that way. Video for Windows can be downloaded free from the Microsoft web
site.

For technical support information, please call 01752 895100. When you call, have information regarding 
your computer configuration available. You may also send e-mail to tech@guildsoft.co.uk.



The text Bounce check box allows text using user defined motion to bounce off the edge of the screen. 
Be aware that when a new segment is begun, user defined bouncing text will start the segment by moving
in the user defined direction!



The Text Clear Button deletes all the text in the text entry box. It does not change any other settings.



Text Definition
The Define Text settings allow to control your text. The controls in this box change slightly depending on 
the motion selected as shown below. If the Motion is User Defined, you will see the box on the right; any 
other motion gives the box on the left.

Click below for more help.

 or 



Click in the text entry box to activate it and then enter your text. As you type, you will remain on the 
same line and the text will scroll to the left. Only press <Enter> if you want two or more distinct lines of 
text to appear. If you enter a long line of text, it will be clipped by the screen edges.



The Effect slide bar changes the rate at which the fading effect occurs - at the slow end it will take a 
lonnnng time for the text to fade; at the high end it is almost instantaneous. It affects both the In and Out 
effects.



You can control the appearance of the text by clicking on the Font... button. This calls up the standard 
font selection dialog that lets you select the font, style, size, effect and color of the text. 

It is important to know that Screen Saver Studio does not incorporate the font in the actual finished 
screen saver. This means that if you use a special font and then run the screen saver on a system that 
does not have that font, the text will be displayed using Windows attempt to recreate the font - and the 
results may not be acceptable. See Text Snapshot Check Box.



The Text In effect determines how the text arrives on the screen. The options are:

Zoom- the text begins as a point and becomes larger until it is full size.
Random Blocks- random blocks appear until all the text is displayed. The effect speed determines the 
size of the blocks - the faster the speed, the larger the blocks.
Horizontal Expand- the center-line of the text appears then it expands simultaneously to the top and 
bottom.
Vertical Expand- the center-line of the text appears then it expands simultaneously to the left and right.
Horizontal Scan- the top or bottom of the text appears, then it builds to the other edge.
Vertical Scan- the left or right of the text appears, then it builds to the other side.
Instantaneously- all the text appears at once.



The Motion pull down menu determines how the text acts on-screen:

user defined- the user gets custom control over the movement.
bounce- the text moves around the screen and when it reaches an edge, it bounds off in the opposite 
direction.
left, right, up or down- the text moves across the screen in the indicated direction. After it exits the 
screen, it reappears coming in on the opposite edge in a random location.
stationary- the text stays where it is placed.
stationary left- the text is placed to the left of the graphic in slot 1. This is a good way to put a label by a 
graphic. If there is no graphic in slot 1, the text will be placed on the very left side of the screen. If the 
graphic in slot 1 is wholly or partially off the screen, the text will always be completely on the screen as 
close to the left side of the graphic as possible.
stationary right, stationary up or stationary down as for stationary left but on the indicated side.



The Text Out effect determines how the text leaves the screen. The options are:

Zoom- the text decreases in size until it disappears.
Random Blocks- random blocks disappear until all the text is gone. The effect speed determines the size
of the blocks - the faster the speed, the larger the blocks.
Horizontal Contract- the top and bottom lines of the text disappear until they meet in the middle.
Vertical Contract- the left and right sides of the text disappear until they meet in the middle.
Horizontal Scan- the top or bottom of the text disappears, then it erases to the other edge.
Vertical Scan- the left or right of the text disappears, then it erases to the other side.
Instantaneously- the entire text disappears at once.
None- the text is not erased from the screen - a copy of the text is left behind. However, anything moving 
over it erases the part it moves over until eventually it is all erased.



The Text Snapshot check box, if checked, ensures that the text will look the same on all systems 
regardless of the fonts installed on that system. Basically, it turns the text block into a BMP and uses it in 
the final screen saver.



The Speed bar determines how fast the text moves across or around on your screen. The speed number 
is actually how many pixels the text moves every update. Thus, at the default Update Rate of 200ms, 5 
updates occur every second. A block of text with a speed of 10 will therefore move 50 pixels every 
second.



The Text Starting Values are dimmed and can't be accessed unless Pixel Offset or % Offset is chosen 
for the particular axis. Values can run from -9999 to 9999.



The Text Starting Point is broken into X and Y coordinates for maximum flexibility. Usually you will have 
both axes set to the same thing, but they can be different. These options are not available when the 
Motion is Stationary Left, Right, Up or Down. The options are:

Keep Old- begin at the same location the text ended at in the previous segment. This is needed to 
maintain smooth motion of text from segment to segment. If there was no text in the previous segment, a 
Random location is used instead.
Preset- uses standard starting locations based on the selected motion of the text. Bounce generates a 
Random location that tries to keep the text block on the screen. Stationary is centered on the axis. Left, 
Right, Up or Down motion puts the starting location just off the edge of the screen. User defined motion 
text uses a random starting location.
Random- places the center of the text block somewhere on the screen. Thus, the text can start partially 
off the screen.
Left Side or Right Side on X axis, on the Y axis Top or Bottom- puts the text just off the indicated edge 
of the screen.
Pixel Offset- starts the center of the text block the specified number of pixels from the center of the 
screen.
% Offset- starts the center of the text block the specified percentage of the screen resolution from the 
center of the screen.



The text Keep Black Transparent check box here is similar to the graphic Keep Black Transparent box. 
You normally want this on unless you want a black box around your text block.



The text Transparent Fade check box here is similar to the Keep Black Transparent box. You normally 
want this on unless you want to see the box around the text until the effect is finished.



The heart of user defined motion is an understanding of the X-Y coordinate system. The center of the 
screen is 0,0. X is the horizontal axis; it increases to the right (+) and decreases to the left (-). The Y axis 
is the vertical axis; it increases to the top (+) and decreases to the bottom (-). By setting the sliders to the 
proper numbers, you can make an object move in any desired direction.

The text X and Y Speed numbers represent how many pixels the text moves every update. Thus, at the 
default Update Rate of 200ms, 5 updates occur every second. Text with an X-speed of 10 and a Y speed 
of 3 will therefore move 50 pixels to the right and 15 pixels up every second.



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button

Document Control-menu button

Maximize button

Minimize button

Name of the application

Name of the document

Restore button



Toggle Clip Marker (Edit menu)

Use this command to change the status of a clip marker. The easiest way to set a clip is to click on the dot
on the main screen. A black dot marks the beginning (as well as the end) of a clip and a white dot means 
the segment is part of a clip. The keyboard command toggles the dot on the left side of the selected 
segment.

See also 
Shortcuts

Main Window:
Keys: CTRL+M



Undo (Edit menu)

The undo command can undo the last Edit action - Cut, Replace, Insert, Edit, Clear, Delete, Insert New 
Segment. After the last action is undone, the command becomes diabled again.

Shortcuts

Tool bar:
Keys: CTRL+Z



The Update Rate determines how often Screen Saver Studio redraws every object on the screen. It is 
measured in milliseconds, so the default of 200ms means that everything is redrawn every 200/1000ths of
a second - that is, 1/5 of a second or 0.2 seconds.

Note that this is the optimum case. It is entirely possible to have so many large graphics that they cannot 
all be drawn in the allotted time. To preserve the look of the screen saver on all systems - no matter how 
slow - screen saver studio figures out how many iterations need to be done and then executes them no 
matter how long it actually takes.

Thus, under the default update rate, if a segment is supposed to last 3 seconds, 15 iterations will be 
done. This could take 3 seconds as planned or it might take 10 seconds if the system is very slow.



Using Help command (Help menu)

Use this command for instructions about using Help.



Ruler command (View menu)

<< Write application-specific help here. >>



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed tool bar button, and keyboard latch state. A check mark appears next to
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Tool bar command (View menu)

Use this command to display and hide the Tool bar, which includes buttons for some of the most common 
commands in Screen Saver Studio, such as File Open.    A check mark appears next to the menu item 
when the Tool bar is displayed.

See Tool bar for help on using the tool bar.



View menu commands

The View menu offers the following commands:

Tool bar Shows or hides the tool bar.
Status Bar Shows or hides the status bar.
Preview Preview the current screen saver document.
Show 
Background

Draw the backgrounds behind each segment in the list.

Element Determines which segment element should be displayed in the list.
Resolution View 1, 2, 4, 8, 16, or 32 segments at once.
Show 
Selection 
Thumbnail

Turn on or off the thumbnail which appears when trying to select a 
graphic.



Viewing a Preview of the Current Screen Saver
To preview the screen saver scripted by your current screen saver document, select Preview in 

the View Menu (Alt V+P) or click the Preview Icon in the Tool bar ( ). Press Alt+F4 or click Close in the
title bar's close box to end the Preview and return to your screen saver document.

Whenever you are previewing or editing a segment, all graphics will appear in the rainbow 
palette. See Building New Screen Savers (.SCR files) or Programs (.EXE files) for more information on 
palettes.



Viewing the Background of a Segment
From Screen Saver Studio's main screen, it is possible to view your segments without a 

background. Simply select Show Background in the View Menu to "uncheck" or turn the option off. Select 
Show Background again to "check" or turn it back on. Though you may not use this feature very often, it 
can reduce the display time for large screen saver documents and it will make a selected segment easier 
to spot.



Viewing the Graphics in a Segment

Alongside of the main window is a row of tabs that say Graphic 1 down to Text. One of these will be active
and appear to be popped out over the others - graphic 1 in the graphic to the right. When you look at all 
the segments in the main screen, you are seeing the graphic (or text) in this slot in the segments. If there 
is no graphic in the selected slot in a segment, you will see a view of the background - unless View 
Background is turned off in which case you see solid black. This is a quick way to find a segment where 
something changes.

There are two ways to change the selected slot. The easiest is to just click on the slot you want to view in 
the tab. Or you can select Element in the View Menu and then the desired slot.



Viewing the Segments in a Document
When you create a new screen saver document, the main screen enables you to view four 

segments per screen. You can change this to 1, 2, 8, 16, or 32 segments. If your screen savers are 
usually only one segment, you will be able to see more of it by viewing only one segment. Conversely, 
you will want to view more segments to keep scrolling to a minimum if working with large multi-segment 
screen saver documents.

In the lower left hand corner of the main screen is a little ruler that not only graphically shows you 
how many segments are being displayed, but also lets you click on a vertical line to change the number of
segments you are viewing.



WAV: A sound format which digitizes an actual sound as a long string of numbers. All systems with sound 
cards should be able to play WAVs.



If you want to create your own .ANM files, you will need to use the included ANIMCOMP.EXE beta 
program.



Background: The mat on which all objects are placed. All other objects are above the background.



BMP: A standard Windows graphic format. If your paint program supports it, when you create new 
graphics you should save them as RLE encoded since this usually makes your final screen saver smaller.



Bounce: A special object motion where the object bounces off the edge of the screen instead of moving 
off of the screen.



Clip: A clip is a run of segments that plays from the first segment of the clip to the last segment of the clip.
When the last segment is played, a different clip is chosen at random to be played.



Duration: How long the movement portion of a segment lasts. It can be set to last a certain number
of seconds, or by how a certain object moves.



Dynamic Palette: A setting designed for slide shows that calculates a palette for every segment. You 
should fade each slide to black before going to the next image, or you will get a palette flash between 
segments.



EXE: An executable program. Screen Saver Studio can build a Presentation EXE, or a self-installing 
screen saver EXE.



Global Palette: A setting that takes all the graphics from the entire screen saver and makes the single 
best palette. The results are usually very good. There is never a palette flash between segments, but it 
can take a while for the palette calculation during the build.



High Color: Also known as 16-bit or 65 thousand color, this is a video mode that displays 65,536 colors. 
(Also used to describe 15 bit color, a mode that displays 32,767 colors.)



JPG: A popular, lossy graphic format. Because of the compression method used, these may not work 
properly with transparent black settings. They will become larger when internally stored in screen savers.



Lossy: A compression scheme that sacrifices information for size reduction. Usually used on graphics. 
(like JPG and PNG) under the theory that the human eye can't detect the difference between the original 
and the compressed graphic. Unfortunately, Screen Saver Studio can run into trouble with transparent 
black settings when using lossy graphic formats.



MIDI: A music format where instruments and notes are defined as numbers. Much smaller in size than 
WAVs, MIDIs will play on most properly installed sound cards. However, songs may not sound the same 
on different systems.



Object: Either a graphic or a block of text. Objects are the "actors" in your screen saver "movie".



Pixel: The basic unit of the screen, each "dot" on the screen is one pixel. A 640x480 screen resolution 
means you can see 640 pixels across and 480 pixels up and down.



PNG: A lossy graphic format. Because of the compression method used, these may not work properly 
with transparent black settings. They will become larger when internally stored in screen savers.



Presentation EXE: A stand-alone program. It must be run like any other program - it does not run 
automatically like a screen saver. It is exited by a key press.



Rainbow Palette: A general palette used while building and previewing your screen savers. It makes a 
fairly good approximation for most graphics, but is bad for photographs.



SCR: The file extension of screen saver files.



Screen Saver: A special program that is run automatically after a predefined length of time has passed 
with no input to your computer. Any key press or mouse movement exits the program. Originally designed
to keep your monitor's screen from getting burned by constantly displaying the same thing for long 
periods of time, screen savers have become fanciful, fun, whimsical programs that amuse or break up the
work-day monotony.



Segment: The basic unit of a Screen Saver Studio screen saver. Each segment has three parts: A 
beginning where objects Fade In, a middle where objects Move, and an end where objects Fade Out.



Graphic Slot: Graphics in a segment are assigned to one of ten slots to keep track of them. The major 
function of a slot is determining how objects pass over each other on screen.



Snapshot: A text setting that turns the text in a segment into a graphic - ensuring that all users will see 
the font and style used no matter what fonts they have of their system.



SSP: Screen Saver Project. The file that tells Screen Saver Studio where to find and how to move all the 
objects in your screen saver.



Status Bar

The status bar is displayed at the bottom of the Screen Saver Studio window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of tool bar buttons as you 
depress them, before releasing them.    If after viewing the description of the tool bar button command you
wish not to execute the command, then release the mouse button while the pointer is off the tool bar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Tool bar

The tool bar is displayed across the top of the application window, below the menu bar.    The tool bar 
provides quick mouse access to many tools used in Screen Saver Studio,

To hide or display the Tool bar, choose Tool bar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    Screen Saver Studio displays the Open dialog box, in which you 
can locate and open the desired file.

Save the active document or template with its current name.    If you have not named the 
document, Screen Saver Studio displays the Save As dialog box.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Places the contents of the clipboard segment over the current segment

Inserts the contents of the clipboard segment before the current segment

Edits the current segment.

Clears the current segment.

Removes the current segment.

Inserts a new segment before the current one

Undoes the last Edit action

Activate the Icon Editor program

Previews the current screen saver

Creates a screen saver file and possibly a program to that will install it for you.

About your version of Screen Saver Studio

Point-and-click help





True Color: Also known as 24-bit or 16 million color, this is a video mode that displays 16,777,216 colors.






